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HFSS-13  часть 2 
 

7. Расчет ЭПР объекта большого электрического размера 
 

Для решения задач, в которых моделируются объекты, имеющие 
большие электрические размеры, используется метод интегральных 
уравнений. Для его обозначения в системе HFSS используется аббревиатура 
EFIE. Существенным отличием метода интегральных уравнений от метода 
конечных элементов, который долгое время был единственным методом 
решения электродинамических задач в HFSS, является то, что дискретизации 
в методе интегральных уравнений подвергается не пространство, а 
поверхность тела, рассеивающего электромагнитные волны. Очевидно, что 
при этом порядок системы линейных алгебраических уравнений оказывается 
существенно меньшим, чем в случае метода конечных элементов. 
Сокращение размерности системы позволяет в реальные сроки 
анализировать поля, порожденные объектами с большими электрическими 
размерами. Решение подобных задач с помощью метода конечных элементов 
не представляется возможным.  

Сравнивая два метода решения граничных задач электродинамики, 
следует отметить, что метод конечных элементов является более 
универсальным методом, который не имеет принципиальных ограничений 
на анализируемую структуру. Метод интегральных уравнений 
демонстрирует большую эффективность лишь в ряде случаев. Дело в том, 
что запись интегральных уравнений основана на знании функции Грина. В 
простой форме функция Грина известна только для ограниченного набора 
объектов, к которым относятся: однородное пространство, слоистые 
структуры с бесконечными слоями, бесконечный экран и т.д. Для них 
целесообразно использовать метод интегральных уравнений. 

Однако, как только речь идет об анализе объекта произвольной формы, 
например, диэлектрического тела сложной конфигурации, то преимущества 
метода интегральных уравнений становятся менее очевидными, так как 
формулировка указанных уравнений усложняется. По существу, приходится 
численно искать неизвестную в аналитическом виде функцию Грина, что 
требует существенных затрат компьютерных ресурсов. В результате 
эффективность двух методов становится сопоставимой. 

Рассеяние волн металлическими телами, расположенными в свободном 
пространстве относится к числу задач, для решения которых метод 
интегральных уравнений весьма эффективен, так как для формулировки 
граничной задачи достаточно знать только функцию Грина однородной 
среды, которая записывается в весьма простой форме.   

В этом проекте (RCS of an Ogive) с использованием метода 
интегральных уравнений рассчитывается  эффективная поверхность 
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рассеяния (ЭПР)  металлического дирижабля. Дирижабль моделируется в 
виде трехмерного объекта, являющегося телом вращения. Поверхность 
дирижабля создается путем вращения кривой вокруг оси 0х (см. рис. 7.1). 
 

 
 

Рис. 7.1. Модель дирижабля 
  

Структура анализируется на  частоте  1.18 ГГц. Она облучается 
плоской волной, падающей под углами ϕθ , . Рассмотрим падение волны в 
плоскости XOY. При этом угол  θ = 90o, а угол φ меняется от  0 до 180o  с 
шагом 2o. 

Будем рассчитывать ЭПР для случая моностатической радиолокации, 
когда направление на точку наблюдения совпадает с направлением, под 
которым волна падает на исследуемый объект. Результаты анализа в виде 
моностатического ЭПР  можно видеть на графике, на котором представлена 
зависимость ЭПР от угла облучения цели IWavePhi, изменяющегося от 0 до 
180º.  Наибольший коэффициент отражения, пропорциональный 
эффективной поверхности рассеяния, как предполагается, будет достигать 
при угле 90º. 

Рассмотрим далее последовательность создания модели дирижабля и 
ее анализа в системе HFSS методом интегральных уравнений. Модель 
создается следующим образом. Сначала в плоскости XOY чертится кривая, 
которая является образующей тела вращения. Создание кривой происходит с 
использованием уравнения в аналитической форме. Затем кривая вращается 
вокруг оси X, чтобы создать 3-D объект. Черчение образующей дирижабля 
выполняется по команде Draw-> Create Equation Curve. По этой команде 
появляется диалог рис. 7.2, в котором задаются координаты кривой, 
зависящие от изменяемой переменной _t. 
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Рис. 7.2. Черчение кривой в пространстве с помощью уравнения кривой в 

параметрической форме 
 
 

Уравнение образующей дирижабля имеет следующий вид: 
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где x, y, z  определены в дюймах (inches), а α - угол образующей,  выбранный 

для данного случая равным 
06.22=α  

Единицы измерения длины по умолчанию могут быть сейчас изменены 
на дюймы,  но возможно их изменить позднее.  
 
1. Кликните Draw>Equation Based Curve. Появляется диалог Equation 
Based Curve (рис. 7.3). 
 

В качестве параметра используем переменную _t , которая совпадает с 
координатой х: x = _t. Уравнение для координаты y приобретает вид: 
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Углы вводятся в радианах. Нужно также задать единицы измерения 
длины, для чего мы умножаем каждое значение (x и y) на величину (1in). 
Итак, в диалоге Equation Based Curve, введите уравнения следующим 
образом (рис. 7.3): 
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             X(_t) = _t*(1in) 
             Y(_t) = (sqrt(1-(_t*sin(.3948)/5)^2)-cos(.3948))/(1-cos(.3948))*(1in)) 
             Z(_t) = 0 
 
           Зададим начальную точку Start _t =-5, конечную точку  End _t=5 и 
количество точек в линии  Points =24 (рис. 7.3). 
 

 
Рис. 7.3. Черчение образующей дирижабля 

 
Нажмите OK, чтобы увидеть кривую линию. 
Найдите в дереве History в разделе Lines ссылку Equation Curve1 и 

дважды щелкните по CreateEquationCurve. Это позволяет видеть окно 
Properties. Если линия не соответствует ожидаемому виду (рис. 7.4), то её  
можно отредактировать. 

В HFSS-IE криволинейные элементы отсутствуют. Таким образом, все 
изогнутые поверхности аппроксимируются сегментированными моделями. С 
учетом этого рекомендуем вводить требуемое число сегментов в поле 
Number of Segments. 
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Рис. 7.4.  Черчение образующей объекта 
 

2. Выберите  кривую EquationCurve1 и затем кликните Draw>Sweep 
>Around Axis. Появляется диалог Sweep Around Axis (рис. 7.5). 
 
3. В диалоге Sweep Around Axis выберите ось X, Angle of sweep = 360, и 
Number of segments = 24. Кликните OK. 
 
 

 
 
Рис. 7.5. Параметры вращения кривой для создания трехмерной модели 

 
Материал по умолчанию для этого объекта выберем, например, медь. 

Обычно дирижабли (рис. 7.6) делаются из алюминия. 
 

 
Рис. 7.6. Вид анализируемого объекта с направлением наблюдения 
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4. Выберите объект Ogive и в окне  Properties кликните copper в разделе 
Material и выберите  редактирование Edit... (рис. 7.7). Это откроет диалог 
выбора материалов. 
 

 
Рис.  7.7. Редактирования свойств материала 

 
5. В окне выбора материала выберите «aluminum» и кликните  OK. Создание 
модели закончено. Она не имеет воздушного бокса, так как в методе 
интегральных уравнений он не используется.  
 
Установка падающей плоской волны. Теперь нужно добавить источник 
падающей плоской волны. Мы будем рассчитывать моностатическую  RCS в 
плоскости x-y. Т.е. радиолокационный коэффициент отражения будем 
рассматривать, облетая дирижабль в плоскости xoy (рис. 7.6). 

Поскольку это моностатическая RCS, нужно будет включить ряд углов 
падения. Для получения точно картины, можно выбрать шаг изменения угла  
равный 3°. Падающая волна задается следующими шагами: 
 
1. Снимем выделение модели и правой кнопкой мыши выберем  Assign 
Excitation>Incident Wave>Plane Incident Wave из выплывающего меню. 
Откроется диалог Incident Wave Source: General Data (рис. 7.8). 
 
2. В этом диалоге выберем опцию Spherical для формата охвата дирижабля и 
оставьте положение фазового центра в точке (0,0,0). 
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Рис. 7.8.  Задание точки излучения плоской волны 

 
3. Кликните  Next и установите в окне Spherical Vector Setup (рис. 7.9) 
значения углов Iwave Phi:      Start = 0, Stop =180 и Step = 3. 
 
4 . Для  IWave Theta  выберите  Start = 90, Stop = 90 и Step = 0. 
 
5. Затем установим величины  Eo Vector Phi =1 и E Theta = 0. 
 

     
 

Рис. 7.9. Задание параметров сферы дальнего поля 
 

6.  Кликните  Next  и затем Finish.  
 
   Возбуждение задано. Падающая волна (Incident Plane) появляется в разделе 
Excitations в дереве проекта. Если вы выбираете её, то в окне появляется 
рисунок дирижабля с «веером» в виде рассчитываемых углов.   
    Возбуждение задано. Падающая волна (Incident Plane) появляется в 
разделе Excitations в дереве проекта. Если вы выбираете её, то в окне 
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появляется рисунок дирижабля с «веером» в виде углов, на которые 
отклоняется падающая плоская волна.   
    Эта установка на решение для решения для падающих волн при  θ=90° и  
для ϕ = 0 …  180° для  61 точек.     Поляризация определяется углом ϕ,  
направленным так, что мы можем рассчитать моностатический 
радиолокационный коэффициент отражения (monostatic RCS). 
 
     Теперь выполним установки на решение, для чего: 
 
1. Нажмите правой кнопкой на  Analysis в разделе IEDesign в окне 
менеджера проекта и выберите  Add Solution Setup, чтобы открыть диалог 
Solution Setup (рис. 7.10). 
 
2. В закладке  General измените частоту Frequency = 1.18 GHZ. Остальные 
параметры оставьте по умолчанию. 
 

           
Рис. 7.10.  Задание частоты расчета 

 
3. Просмотрите данные в закладке  Options  -   уплотнение разбиения на 
ячейки lambda refinement = 0.25 (=λ0/4). Установки на расчет завершены. 
 
     Чтобы запустить моделирование: 
 
1. Нажмите правой кнопкой мыши на Setup и выберите команду Analyze. 
2. Сохраните задачу и введите имя проекта. Моделирование выполнится за 
две итерации. 
 

Вывод тока на поверхности.  Чтобы увидеть ток на поверхности 
дирижабля (рис. 7.11): 
 

1. Выберите поверхность модели и задайте вывод распределения тока 
командой Fields>J>Mag_J. Это открывает диалог Create Field Plot. 
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Рис.  7.11.   Токи на поверхности дирижабля 

 
 

2. Кликните Done.  Вы должны видеть индуцированный ток, который 
наводится на металле  при воздействии плоской падающей волны. 

 
     Вывод графика коэффициента RCS.     
    Чтобы графически изобразить RCS, сначала следует ввести установки 
дальнего поля  - аналогично тому, как делается в HFSS. Создадим установки 
дальнего поля только  с  одним углом φ = 0 ° и одним углом  θ = 90°.  
    Мы будем графически изображать зависимость моностатического RCS 
при изменении угла падения плоской волны phi. Поэтому каждой точке 
наблюдения соответствует только один угол (рис. 7.12). 
 

 
 

Рис. 7.12. График зависимости моностатического радиолокационного 
коэффициента отражения при изменении угла падения Phi 
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    Чтобы вывести на график зависимость  моностатического RCS в 
зависимости от азимутального угла phi падающей плоской волны:      
 
1. Кликните правой кнопкой на Radiation в дереве проекта и выберите  Insert 
Far Field Setup>Infinite Sphere... Появляется диалог Far Field Radiation 
Sphere Setup. 
 
2. Введите Start и  Stop для  Phi равными 0,  и  шаг 10º (рис. 7.13). 
 
3. Введите  Start и Stop для Theta = 90º и Step size =10º.  
 

 
 

3. Кликните OK. Это закроет диалог и создаст сферу InfiniteSphere1 в 
разделе Radiation в дереве проекта. 
 

 
Рис. 7.13. График установки данных расчета дальнего поля. Фактически  

один угол φ  и один угол Θ 
 
5. Чтобы создать график, кликните на Results в дереве проекта и задайте 
команду  Create Far Fields Report>Rectangular. 
 
     Итак, в данном разделе рассчитан радиолокационный коэффициент 
отражения для объекта, размер которого намного больше длины волны. В 
расчете использован метод моментов, реализованный в программе  HFSS-IE.
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8. Полосовой волноводный фильтр 

 
      

    В этом разделе мы рассмотрим анализ с помощью HFSS полосового 
фильтра, который представляет собой широко использующуюся на практике 
гребенчатую структуру. Далее модель полосового фильтра мы будем 
использовать для иллюстрации дополнительных возможностей HFSS, таких 
как учет температурных зависимостей и режим подстройки Tune. 

     Синтез СВЧ фильтра можно выполнить, используя на первом этапе 
проектирования популярную программу Microwave Office  [6]. Утилита 
Synthesis Filter этой программы позволяет рассчитать обобщенные 
параметры, входящих в состав фильтра линий передачи, а также их размеры, 
реализующие заданные частотные характеристики. Отметим, что расчет 
геометрических размеров возможен только для линий передачи планарного 
типа: полосковых, микрополосковых и т.д. Аналогично анализ частотной 
характеристики фильтра в системе MWO можно осуществить только для 
полосковых конструкций. В тоже время на практике часто применяются 
гребенчатые фильтры на основе линий передачи с цилиндрическими и 
прямоугольными проводниками, которые имеют существенно более 
высокую добротность, чем полосковые линии. Анализ таких структур 
возможен средствами HFSS. 
   Выполним анализ трехмерного гребенчатого полосового фильтра (рис. 8.1) 
с полосой 1 ГГц. Фильтр состоит из восьми штырей, каждый из которых 
является резонатором. На входе первого штыря подключена коаксиальная 
линия  передачи с характеристическим сопротивлением 50 Ом. 
 

 
 

Рис. 8.1. Вид фильтра в интерфейсе HFSS-13 
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    Гребенчатый полосовой фильтр имеет порядок, связанный с количеством 
резонаторов. От количества резонаторов зависит качество фильтра: 
неравномерность передачи в полосе пропускания, и спад коэффициента 
передачи вне полосы пропускания.  
 
   Длина отдельных резонаторов не превышает четверти длины волны, а часто 
заметно меньше за счет эффекта укорочения, возникающего благодаря 
концевой емкости между штырем и стенкой корпуса. Расстояние между 
штырями определяет коэффициент связи между резонаторами (рис. 8.2). 

 

 Рис. 8.2. Размеры гребенчатого фильтра 
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    При решении этого примера используются многие возможности 
программы  HFSS, включая расчет зависимости характеристик фильтра от 
температуры окружающей среды. Особенность метода Driven Terminal 
заключается в том, что порты здесь создаются как источники  относительно 
внешнего корпуса. 
 
Создание нового проекта.  Чтобы создать новый проект  кликните команду 
File>New New. Из меню Project, выберите команду Insert HFSS Design 
Design.  Чтобы установить метод решения, кликните  HFSS>Solution Type. 
Появляется диалог Solution Type (рис. 8.3), в котором выберите Driven 
Terminal.  
 

 
 

Рис. 8.3. Выбор метода расчета полосового фильтра 
 

Метод Driven Terminal рассчитывает S параметры для портов, которые 
образованы многопроводными линиями передачи (multi-conductor 
transmission line ports).  Элементы S-матрицы при этом определяются через  
напряжения и токи, что отличает ее стандартного энергетического 
определения матрицы рассеяния через волны мощности. Отметим, однако, 
что для линий передачи с ТEM – волнами (коаксиальная, симметричная 
полосковая и т.д.), оба определения матрицы рассеяния дают эквивалентные 
результаты. 
 
Создание трехмерной модели.  Установите единицы модели. Для этого 
выполните следующие действия: 
 
1. Кликните  Modeler>Units. Откроется диалог Set Model Units (рис. 8.4). 
2. Выберите: in (inches). 
3. Кликните OK. 
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Рис. 8.4. Установка единиц длины - дюйм (34.5 мм) 

 
 
     В этом примере при черчении будем применять ввод координат в линейке 
состояния, т.е. в виде цифр (рис. 8.5). Чтобы начертить трехмерную 
подложку: 
 
1. Кликните Draw>Box. 
2. Используйте поля ввода координат, вводя координаты 
                      X: -1.0,  Y: -1.7,  Z: -0.3125,    нажимая каждый раз Enter. 

 
Рис. 8.5. Показание линейки состояния 

 

 
  Рис. 8.6. Размеры корпуса фильтра в дюймах (in) 

 
3 . Используя поля ввода координат, введем противоположный угол 
бокса            dX: 2.0,  dY: 3.4,  dZ: 0.0,         нажимая Enter. 
 
4.  Используя поля ввода координат, введем высоту подложки 
                     dX: 0.0,  Y: 0.0, Z:  0.625,          нажимая  Enter. Корпус фильтра 
будет иметь вид, показанный на рис. 8.6. 
   Создание внешнего цилиндра входной коаксиальной линии. Чтобы создать 
внешний проводник коаксиальной линии: 
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1. Кликните  Modeler>Grid Plane>YZ, чтобы выбрать активную плоскость,  
     на которой будет чертиться основание цилиндра. 
2. Кликните  Draw>Cylinder. 
 
3. Используя поля ввода координат, введите центральное положение        X: 
1.0,   Y: -0.9,   Z: 0.0, и нажмите Enter. 

 
Рис. 8.7.  Поля ввода координат внизу интерфейса программы HFSS 

 
4 . Используя поля ввода координат, введите радиус цилиндра (рис. 8.7) 
            dX: 0.0,     dY: 0.14,     dZ: 0.0    и нажмите Enter. 

 
Рис.  8.8. Корпус фильтра и первый цилиндр коаксиальной линии 

 
5 . Используя поля ввода координат, введите высоту цилиндра 
           dX: 0.75,   dY: 0.0,     dZ: 0.0   и нажмите Enter. 
 
    В окне свойств установите имя   feed1 и оставьте цилиндр заполненным 
вакуумом (рис. 8.9). Кликните OK. 
 

 
Рис. 8.9. Выбор вакуума для заполнения пространства 

 
 
           Создание внутреннего проводника коаксиальной линии. Чтобы 
начертить внутренний  провод коаксиальной линии на входе фильтра: 
 
 
1. Кликните Draw>Cylinder. 
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2. Используя поля ввода координат, введите положение центра 
           X: 1.0,   Y: -0.9,      Z: 0.0      и нажмите клавишу Enter. 
3. Используя поля ввода координат, введите радиус цилиндра 
         dX: 0.0,   dY: 0.06,  dZ: 0.0     и нажмите  Enter. 
4. Используя поля ввода координат, введите  высоту цилиндра 
        dX: 0.75, dY: 0.0,     dZ: 0.0,    нажмите Enter. 
 
   Зададим имя этого цилиндра (рис. 8.10) как  feedpin1 и  материал его 
заполнения как PEC. 

 
 

Рис. 8.10. Внутренняя жила коаксиального ввода 
 
     Эта внутренняя жила имеет продолжение внутрь корпуса фильтра.   
Чтобы начертить внутреннюю линию коаксиальной линии (штырек): 
 
1. Кликните Draw>Cylinder. 
 
2. Используя поля ввода координат, введите положение центра 
        X: 1.0,       Y: -0.9,      Z: 0.0,      и нажмите Enter. 
3 . Используя поля ввода координат, введите радиус цилиндра 
       dX: 0.0,     dY: 0.06,   dZ: 0.0,      и нажмите Enter. 
4. Используя поя ввода координат, величине высоту цилиндра 
       dX: -0.15,  dY: 0.0,     dZ: 0.0,    нажмите Enter. 
 
    Задайте имя этого цилиндра feedprobe1. 
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Рис.   8.11. Штырек связи с фильтром 

 
Создание резонаторов 

 
   Резонаторы будут чертиться как металлические параллелепипеды. Для 
черчения параллелепипеда (рис. 8.12) задается точка, а затем размеры. Для 
создания резонатора с именем l1: 
 
1. Кликните Draw>Box. 
 
2. Используя поля ввода координат, введите положение бокса 
       X: 0.85, Y: -0.9625, Z: -0.03,   нажмите Enter. 
3 . Используя поля ввода координат, введите противоположный угол бокса 
      dX: -1.7, dY: 0.125, dZ: 0.06,    нажмите Enter. 
 

 
 

Рис. 8.12. Черчение первой линии фильтра 
 
    Для создания штыря фильтра с именем l2 (рис. 8.13): 
 
1. Кликните Draw>Box. 
2. В поля ввода координат, введите положения бокса 
        X: -1.0,       Y: -0.75,    Z: -0.03,  нажмите клавишу Enter. 
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3. Далее введите координаты противоположного угла бокса 
       dX: 1.818,  dY: 0.125,  dZ: 0.06,  нажмите Enter. 
 

 
 

Рис. 8.13. Черчение второй линии фильтра 
 
     Для создания третьего штыря фильтра с именем l3 (рис. 8.14): 
 
1. Кликните  Draw>Box. 
 
2. Используя поля ввода координат, введите точку параллелепипеда: 
    X: 1.0,        Y: -0.48,       Z: -0.03, нажмите Enter. 
3. Используя поля ввода координат, введите его размер по X: 
    dX: -1.818,  dY: 0.125,  dZ: 0.06, нажмите Enter. 
 

 
Рис.  8.14. Черчение третьей линии фильтра 

 
   Чтобы создать  четвертый резонатор l4 (рис. 8.15): 
 
1.  Выберите команду  Draw>Box. 
2. Используя поля ввода координат, введите позицию бокса: 
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    X: -1.0,     Y: -0.2,      Z: -0.03 и нажмите Enter. 
3. Используя поля ввода координат, введите противоположный угол бокса: 
    dX: 1.818, dY: 0.125, dZ: 0.06, нажмите Enter. 
 
   Задайте также имя этого элемента l4 в окне Properties и кликните OK. 
 

 

Рис. 8.15. Созданный четвертый 
резонатор фильтра 

Рис. 8.16. Выделенное сечение порта 

 
Создание волнового порта 

 
    Выделите фаску порта (рис. 8.16), для чего: 
 
1. Кликните команду Edit>Select>Faces (или нажмите F). 
2. Выберите внешнюю фаску коаксиальной линии при  X=1.75in. 
     
     Чтобы задать возбуждение на волновой порт: 
 
1. Кликните  HFSS>Excitations>Assign>Wave Port. Появляется диалог  
    Reference Conductors for Terminals (рис. 8.17). 
2. Задайте имя порта как p1. 
3. Выберите опцию для названия терминала Use port object name. 
4. Оставьте опцию Use as Reference (рис. 8.17) неотмеченной. 
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Рис.  8.17. Описание порта 
 

Рис. 8.18. Значок нагрузки в дереве 
проекта и диалог терминала 

            
5. Кликните OK.  В дереве проекта под Excitations появляется знак нагрузки 
p1.   В методе решение Terminal к каждому порту задается опорный 
импеданс. Поэтому одновременно c  портом появляется и значок нагрузки в 
дереве проекта (рис. 8.18).  
     Далее выполним вращение вокруг центра корпуса с копированием, для 
созданной части фильтра. Чтобы выбрать объекты для дублирования: 
 
1. Нажмите “O”.  По команде Edit>Select>By Name появляется диалог Select 
Object (рис. 8.19). 
 
2. Выберите в нем объекты с именами: feed1, feedpin1, feedprobe1, l1, l2, l3, 
l4, удерживая  Ctrl + Left. 
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Рис. 8.19. Диалог выделения объектов Рис. 8.20. Диалог вращения и 

дуплицирования части фильтра 
 
 
3. Кликните OK.  Чтобы создать оставшуюся часть штырей фильтра, 
выполним копирование с разворотом на 180º для чего кликните 
Edit>Duplicate>Around Axis, а затем в диалоге рис. 8.20 выберем: 

Axis: Z 
Angle: 180 
Total Number: 2 

 и кликните OK. 

 
 
Рис. 8.21. Дублирование половины элементов, с помощью вращения вокруг 
оси 
 
     Модель полосового фильтра примет вид, показанный на рис. 8.21. 

 
Просмотр граничных условий.   Чтобы проверить, как установлены 
границы, кликните HFSS>Boundary Display (Solver View).    После 
предварительного решения появляется диалог Solver View of Boundaries 
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(рис. 8.22). В этом диалоге опцию  Visibility можно отметить для границ, 
которые вы желаете увидеть. Отметим следующее: 
 
- Земляная плоскость background (Perfect Conductor) показывается если 
отмечено имя outer (рис. 8.22). 
 

 
Рис. 8.22. Опции просмотра границ 

 
-  Все проводники, на которые назначены граничные условия Perfect 
Conductors будут показаны как граница smetal. 
     Кликните View>Visibility,  чтобы снять видимость каких-либо частей 
проекта.  Можно также изменить вид граничных условий и портов.  
Видимость объектов можно установить в диалоге, который появляется по 
команде View->Active View Visibility (рис. 8.23). 
 

 
Рис. 8.23. Выбор режима видимости объектов, входящих в проект 

 
    Просмотр видимости граничных условий и объектов позволяет проверить 
верность создания конструкции. Нажмите также HFSS->Validate Check, 
чтобы запустить валидатор проверки геометрического построения задачи. 
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Если после проверки валидатора замечаний нет, то можно выполнять 
установки на анализ. 
     Установки на анализ.    Кликните HFSS>Analysis Setup>Add Solution 
Setup. Появляется диалог Solution Setups (рис. 8.24). В закладке General 
сделайте  установки, показанные на рис. 8.24. 
 

 

Рис.  8.24.Добавление расчета в 
диапазоне частот 

 

Рис. 8.25. Задание расчета в 
диапазоне частот методом 
быстрой развертки 

 
 
    Для  расчета в диапазоне частот кликните  HFSS>Analysis Setup>Add 
Sweep. Появляется диалог Edit Sweep, в котором зададим параметры, 
указанные на рис. 8.25. 
 
Расчет характеристик полосового фильтра.  Чтобы запустить 
процесс решения, кликните  HFSS>Analyze.   Чтобы увидеть процесс 
решения и диалог Solution Data: 
 
1. Кликните HFSS>Results>Solution Data. Появляется диалог Solution Data. 
 
2. Откройте закладку Profile, чтобы видеть файл решения. 
 
3. Откройте закладку Convergence,  чтобы видеть данные о сходимости 
решения. Сходимость можно видеть в  табличном виде (Table Table), или в 
графическом представлении (Plot). 
 
4. В закладке  Matrix Data можно видеть матрицу. Причем, чтобы увидеть 
изменение данных матрицы Matrix Data во время расчета, в  Setup1 выберите 
Last Adaptive. 
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5. Кликните закладку  Mesh Statistics, чтобы видеть данные о сетке 
разбиения. 

 
    Расчет будет выполнен на средней частоте 1.5 ГГц и  в диапазоне частот 
от 0.6 до 2.4 ГГц. С разверткой типа Fast выполнится расчет в тех частотных 
точках, где характеристики фильтра изменяются с большой скоростью.  
 
    Вывод характеристик на графики.  Чтобы вывести частотные 
зависимости S-параметров фильтра от частоты: 
 
1. Кликните HFSS>Results>Create Terminal Solution DataReport> 
    Rectangular Plot.  Открывается диалог Reports. 
2. Задайте следующие опции: 

   Solution: Setup1: Sweep1 
   Domain: Sweep 
   Quantity: St(feed1_T1,feed1T1); St(feed1_T1,feed1T2) 
   Function: dB 

3. Кликните кнопку  New Report. 
4. Нажмите  Close.  
 

 
 
Рис. 8.27. Частотная характеристика волноводного гребенчатого фильтра 
и добавление маркеров на график 
 
    Затем можно прибавить другую характеристику St(feed1_T2,feed1_T1) в  
dB, нажимая кнопку Add Trace и затем кнопку Done. 
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Рис.  8.28.Частотные характеристики фильтра 

 
    Для удобства просмотра графика можно изменить  масштаб. Для этого 
сделайте следующее: 
 
1. Дважды кликните на  Y-axis. Появляется диалог свойств Y-оси. 
 
2. Кликните закладку  Scaling, в которой установлены опции: 

Autoscale: Снимите эту опцию 
Min: -1.0 
Max: 0.0 

 
3. Кликните  OK. В этом случае можно более точно увидеть изменение 
коэффициента передачи в полосе пропускания фильтра. 
 
Просмотр поля внутри фильтра.   В данном фильтре нужно 
установить источник, который имеет внутреннее сопротивление. Такой 
источник называется Terminate Port.   Чтобы установить нагрузки порта: 
 
1. Кликните HFSS>Fields>Edit Sources. Появляется диалог Edit Sources, в 
котором сосредоточены данные о всех источниках проекта. В этом диалоге 
выберите: 

Select source: p2:T1 
Terminated: Checked 
Resistance: 50 
Reactance: 0 

4. Кликните OK. 
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Рис.  8.29. Редактирование источников, включенных в проект 
 
   Вывод рассчитанного поля в сечении.  Выберите плоскость 
XoY, активизируя Global XY Plane. 
 
1. Используя  Model Tree,  разверните папку  Planes. 
2. Выберите  плоскость Global: XY. 
3. Кликните  HFSS>Fields>Fields>E>Mag_E. Открывается диалог Create  
    Field Plot, в котором нужно выбрать: 

Solution: Setup1 : LastAdaptive, 
Quantity: Mag_E, 
In Volume: All. 

4. Кликните кнопку  Done. 
 
     Если нужно изменить вид графика поля, например подчеркнуть слабые 
поля,  кликните HFSS>Fields>Modify Plot Attributes.  Открывается диалог 
Select Plot Folder. 
 
    Выберите E Field, а затем следующие опции в диалоге E-Field1 

Откройте закладку Scale. 
Выберите  Use Limits, и установите: 

                Min: 5, 
               Max: 1500, 
               Scale: Log. 

 
    Кликните  Close. Поле на поверхности приобретает более понятный вид 
(рис. 8.30), в котором можно оценить и резонансные явления в фильтре. 
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Рис.  8.30. Вид поля в среднем сечении фильтра 
 
    Итак, в этом разделе было выполнено черчение и расчет трехмерного 
фильтра на штырях. Чтобы выполнить дальнейшую оптимизацию фильтра, 
нужно задать переменные, выбрать метод оптимизации и целевую функцию. 

      Объекты, которые используются как компоненты в проектах комплекса 
Ansoft,  которые размещены в интерфейсе схем (Workbench Project Schematic) 
можно  рассматривать как системные. В комплексе Ansoft программы, 
которые служат для решения схемных и системных задач, это: Rmxprt 14.0, 
Designer 6.1, и Simplorer 9.0. Такие продукты Ansoft, как HFSS 13.0, Maxwell 
14.0 и Q3D Extractor служат для электродинамического решения структур.  
Если вы вызываете  ANSYS DesignXplorer  (рис. 10.31), то переменные 
любого проекта также экспортируются в проект и доступны из интерфейса 
Workbench.   

 

Рис.  8.31. Добавление режимов решения и оптимизации 

     Все продукты  Ansoft объединяются в общем интерфейсе Workbench 
команды, управления и т.д.   Одна из возможностей, имеющихся в HFSS v.13 
– расчет температуры.  Эти возможности будут описаны в следующей главе. 
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     9. Учет температурных режимов  в HFSS 

 
 
 
Учет влияния температуры на параметры СВЧ систем является 

комплексной задачей, которая допускает разные формулировки. Первая 
формулировка состоит в учете зависимости от температуры окружающей 
среды, которая задает температуру СВЧ устройства и сказывается на 
параметрах материалов, формирующих ее, а также на размерах ее элементов. 
В такой постановке задача является линейной, поскольку обратная связь, то 
есть влияние СВЧ мощности на температуру объекта не учитывается.  

В рамках второй формулировки необходимо рассчитать температуру 
объекта с учетом нагрева, обусловленного воздействием на него достаточно 
мощного СВЧ сигнала. Этот подход связан с расчетом параметра SAR 
(Specific Absorbtion Ratio). При расчете этой характеристики сначала 
определяются потери в материале, а затем находится относительная 
величина поглощаемой в нем мощности. Следовательно, температура будет 
зависеть от мощности генератора. 

Наконец, третья формулировка требует учета не только изменений 
температуры из-за воздействия на объект СВЧ сигнала, но и изменений его 
параметров, обусловленных СВЧ нагревом. 

В этом разделе мы рассмотрим некоторые возможности HFSS, 
связанные с температурным режимом и его изменениями. 

Описание зависимости материалов от температуры. Рассмотрим 
возможность учета зависимостей параметров материалов от температуры. 

Каждый материал, включенный в проект, может  быть описан 
зависимостями своих характеристик от температуры. Эта зависимость может 
быть применена к любым свойствам материала: диэлектрической 
проницаемости,  проводимости и пр. Зависимость может быть задана в 
табличном виде, а может быть задана в виде формул. 

Нужно также задать температуру каждого объекта. По температуре 
HFSS рассчитывает характеристики материалов. Используя эти значения, 
рассчитываются СВЧ характеристики системы. Таков порядок учета 
температуры нагрева объектов в HFSS.  

 
Командой Edit-> View Edit Material вызовем диалог рис. 9.1, в 

котором: 
 
 1. Отметим режим Thermal Modifier в разделе View/Edit Modifier for.  
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Рис. 9.1. Включение температурных характеристик в свойства описания 
материалов 

     В этом случае таблица свойств материалов Properties of the Material  будет 
расширена и включен столбец Thermal Modifier.  

2. Выберите Edit... из выплывающего меню, или None. Появляется диалог  
Edit Thermal Modifier. 

3. Выберите  кнопку  Expression, чтобы вывести текстовое поле Parameters 
Modifier  или кнопку Quadratic, чтобы показать таблицу для Basic 
Coefficient Set и Advanced Coefficient Set. 

   В случае описания зависимости в виде выражения Expression, можно 
записать уравнение для температурной зависимости в поле Parameters 
Modifier.  

  Отметьте опцию Use temperature dependent data set  в поле  Modifier text 
field.  Теперь можно зависимость характеристик от температуры ввести в 
виде табличного набора данных Add/Import Dataset.  

   Если выбрана опция  Quadratic,  в закладке Basic Coefficient, можно 
отредактировать поле для TempRef и единиц, и поля для  C1 и C2 для 
следующего уравнения: 

P(Temp) = Pref[1+ C1(Temp - TempRef) + C2(Temp - TempRef)^2], 

где  Pref  определяется как относительная диэлектрическая проницаемость 
(например). В этой формуле P-параметр. 
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• Если выбрана опция Quadratic, то в закладке Advanced Coefficient Set 
(рис. 9.2),  можно установить нижнюю и верхнюю границу температуры  (TL 
и TU соответственно). 

 

Рис. 9.2. Выбор верхней и нижней границ изменения температуры 

    По умолчанию, они рассчитываются автоматически. Сняв опцию Auto 
Calculate TML, TMU¸ можно ввести новые величины нижней  (TML) и 
верхней границ изменения температуры (TMU). 

Установка температуры объектов. Чтобы установить температуру объекта: 

1. Используйте команду  HFSS или HFSS-IE>Set Object Temperature,  
чтобы вывести диалог Temperature of Objects (рис. 9.3).  

   В этом диалоге  сводится в таблицу объекты проекта. В первом столбце 
перечисляется имя объекта, затем материал,  затем режим включения опции 
свойств зависимости температуры, затем единицы температуры.  
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Рис. 9.3. Диалог включения температурных зависимостей отдельных 
объектов структуры в температурный анализ 

2. Чтобы редактировать свойства, отметьте опцию  Include Temperature 
Dependence.  Это делает возможным выделять объекты и устанавливать на 
них температуры. Заголовки столбцов для Object Name и столбцов  Material  
включают стрелки для направления сортировки. Можно инвертировать 
направление сортировки, нажимая на заголовок каждого столбца.  

   Если список большой, можно использовать поле Select by name. Введите 
имя объекта и нажмите Select. Выбранные объекты высвечиваются. Вы 
можете сделать несколько выборов. 

3. Чтобы установить температуру на выбранный объект или объекты, введите  
переменную или конкретную величину, или выберите существующее имя в 
поле текста. 

4. Выберите единицы из столбца Unit. 

5. Кликните Set, чтобы применить эту величину к выбранному объекту, или 
кликните Set Default чтобы установить это значение по умолчанию.   Если 
нажать Set Default, то столбец для выбранных объектов покажет величины 
их температур. 

6.  Чтобы отредактировать материал для объекта, когда диалог закрыт, вы 
можете кликнуть на столбец материала, и увидеть список в выплывающем 
меню материал и кнопку Edit....  
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   По команде HFSS->Set Object Temperature можно установить температу-
ру на объект. 
    После расчета температурного распределения, его можно вывести в виде 
поля командой Fields->Plot Fields->Other…->Temperature (рис. 9.4). 

 
 

 
 
Рис. 9.4. Вывод поля распределения температуры в корпусе рупорной 
антенны 
     
    Диалог температуры показан на рис. 9.5.  Отметим однако, что полноцен-
ный расчет температурной зависимости с учетом линейного расширения 
материалов и т.д. выполняется в комплексе ANSYS. 
 

 
Рис.  9.5. Диалог вывода карты распределения температуры 
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     В дереве проекта интерфейса ANSYS находятся опции и операции, 
которые предназначены для связи температурных характеристик объектов 
(рис. 9.6). 
 

 

Рис. 9.6. Дерево проекта в программе ANSYS Mechanical 
 

 

Возможность обратной связи по температуре между ANSYS 
Mechanical и HFSS.     

    Эта  опция появляется в  закладке Advanced    в  диалоге  Solution  Setup.  
Откройте эту закладку, если вы хотите использовать двунаправленную 
термальную связь между  HFSS или Maxwell и интерфейсом ANSYS. Вы 
должны сделать этот выбор перед запуском на решение (рис. 9.7). Тогда 
у  вас  будет  возможность  двунаправленной  передачи  данных  о 
распределении  температуры  из  интерфейса  ANSYS  Workbench  к  HFSS 
или Maxwell. 
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Рис. 9.7. Опция включения температурных параметров  

     

   Перед тем, как решать задать  на  HFSS или Maxwell, для этого типа 
объекта, вы должны поставить начальные величины для температурной 
зависимости объектов (рис. 9.8). 

 
Рис. 9.8.  Задание начальной температуры на каждый объект с 

учетом температурной зависимости 
 
 
    Если вы отмечаете опцию Enable Thermal feedback from ANSYS 
Mechanical, будет создаваться поддиректория с расширением .THM в папке 
Solution, включенной в проект, когда  будет осуществляться импорт данных 
через интерфейс из  HFSS или Maxwell.  В этой директории, записывается 
новый файл centroid.xml (рис. 9.9), чтобы использоваться  в будущем выводе 
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распределения температуры.  Программа  ANSYS Workbench 12  
последовательно экспортирует информацию о температуре в файл, 
называемый  mechanical.ths в той же самой директории Project. 
 

 
Рис. 9.9. Место расположения файлов с данными о температуре 

 

      В интерфейсе ANSYS Workbench 12 имеется команда Export Results. 

 
   Расчет температурного распределения с помощью связи с 
программой ANSYS Thermal.   
    После решения проекта на HFSS 13 или Maxwell, с установкой опции 
“Enable Thermal Feedback from ANSYS Mechanical”  в закладке Advanced 
установки на анализ,  и после выполнения связанного термоанализа в 
ANSYS Workbench 12, вы можете получить распределение температуры  из 
теплового решения. ANSYS Workbench 12 запишет файлы обратной связи 
непосредственно в директорию Project Solution HFSS, или Maxwell 
C:\Ansoft\HFSS13.0\Help\hfss. chm::/savinganewproject. htm > каталог.  
     В этом случае: 

1. Откройте проект в HFSS или Maxwell.  

2. Запустите на анализ этот проект, автоматически используя обратную связь 
от ANSYS Workbench 12. 

    Не нужно делать никаких дополнительных изменений к установкам 
решения в HFSS или Maxwell.  Просто запустите анализ командой Analyze. 
HFSS или Maxwel знает, что в решении нужно использовать информацию об 
измененной температуре.    HFSS или Maxwell выдаст измененные 
результаты, основанные на новом температурном распределении, которые 
могут быть импортированы ANSYS Workbench 12 через созданную ранее 
ANSYS  Termal Link. Чтобы сделать это, выполните следующее: 
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1. Закройте проект HFSS или Maxwell. 

2. В интерфейсе ANSYS Workbench 12, очистите командой  Clean ранее 
импортированные данные.  

3. Импортируйте новый результат из HFSS или Maxwell. 

4. Запустите термальное моделирование снова (рис. 9.10).  

 

 

   Рис.  9.10. Расчет температурных характеристик с помощью Re-solving 
After ANSYS Thermal Link Feedback 
      
    В закладке  Edit Thermal Modifier  можно установить нижнюю и 
верхнюю границу, в которых будет верна квадратичная зависимость 
изменения температуры, заданная выше. 

 
    После окончания расчета, нужно выделить объект (рис. 9.11), на котором 
мы хотим вывести поле и значения температур,  и затем зададим команду 
HFSS -> Set Object Themperature. 
 
 



125 
 

 
Рис.  9.11. Вывод поля температуры на плоскости анализируемых объектов 
    
    В разделе Field появляется раздел температуры на объекте (рис. 9.12). 
 

 
 

Рис. 9.12. Иконка в дереве проекта, которая показывает сохранение 
распределение температуры 

 
    Таким образом, система Ansoft, включающая программы 
электродинамического анализа и программы механического анализа 
конструкций в температурном режиме, позволят выполнить 
электродинамический анализ в условиях изменения геометрии при 
изменении температуры. Для решения таких задач нужна специальная 
лицензия. 
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10. Реализация режима подстройки в HFSS 
 
    В ранних версиях HFSS было несколько опций, позволяющих 
оптимизировать анализируемую конструкцию. Часто использовалась 
операция перебора, когда изменяется один, или два параметра, а остальные 
остаются неизменными. Для решения такой задачи программа HFSS для 
каждого перебираемого параметра полностью решала электродинамическую 
задачу. В версии HFSS-13 появилась возможность решить эту задачу 
быстрее и эффективней операцией Tune, так, что после решения можно 
будет менять вручную движок со значением параметра, и тут же видеть, как 
меняются характеристики анализируемого устройства. 
 
     Для того, чтобы реализовать операцию Tune, сначала нужно иметь 
переменные в проекте. Тогда в диалоге Solution Setup появляется закладка 
Derivative, в которой нужно отметить, что программа должна найти 
производные, т.е. приращение функции в зависимости от изменения 
аргумента.  После расчета с такой опцией, производные используются через 
команду Tune Report для мгновенного вывода и  исследования малых 
вариаций конструкции, без необходимости повторного решения. 
"Номинальное" решение, плюс производные содержат всю информацию, 
необходимую, чтобы узнать, как меняются характеристики при небольших 
изменениях параметров конструкции. 
   Рассмотрим пример F-образной пач-антенны (рис. 10.1). Она состоит из 
изломанного в виде буквы F вибратора, который закорочен с земляной 
платой на правом конце и имеет разомкнутую линию на другом. 

 
Рис. 10.1. Вид сбоку на планарную F образную антенну с подстраиваемым 

положением порта 
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Рис. 10.2. Вид сверху на планарную F-антенну 

 
 

Питание от дискретного источника поступает в антенну через 
цилиндрический провод с радиусом 1 мм. Пусть переменной является 
смещение точки питания F-образной антенны (равное 4.8 мм на рис. 10.2). 
Положение точки питания определяет ее входное сопротивление на 
центральной частоте рабочего диапазона. 
 
     Чтобы  HFSS рассчитал производные для какой-либо переменной: 
 
1. Откройте закладку  Derivative в диалоге Solution Setup (рис. 10.3).  
2. Для переменной feed_pos, которая будет подстраиваться, выберите опцию 
Use. 
 

 
Рис. 10.3. Установка опции для расчета производной feed_pos 

 
 
     В этом режиме будет рассчитываться производные по параметру 
feed_pos, и после выполнения расчета можно будет командой Tune Report 
меню Result видеть изменения S-параметров при варьировании положения 
точки питания антенны. Эта возможность не относится к частотам и 
ближним полям. 
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      Создание модели F-образной антенны. В глобальной системе координат 
построим основание антенны. Командой Create -> Box начертим бокс, 
параметры которого показаны на рис. 10.4. 
 

 
 

Рис. 10.4.  Основание  антенны  высотой 5 мм. 
 
   Далее начертим верх планарной антенны операцией Draw->Box, с 
размерами, показанными в диалоге рис. 10.5. 
 

 
 

Рис. 10.5. Верх пач-антенны толщиной 1 мм 
 

    Цилиндр коаксиальной линии, положение которой меняется при 
изменении переменной feed_pos (рис.10.5) создается операцией Draw-
>Cilinder, и размеры его можно откорректировать в диалоге рис. 10.6. 
Положение центра можно будет изменять, вводя параметр feed_pos. 
 

 
Рис.  10.6. Параметры цилиндра 
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    Охватим модель антенны боксом, которую начертим командой Draw Box 
(рис. 10.7) и на поверхность которой установим граничное условие Radiate. 
 

 
 

Рис.  10.7. Размер бокса излучения, который охватывает антенну 
 

   В нижней части коаксиальной линии поставим порт, выделяя поверхность 
цилиндра (рис. 10.8). 
 

 
Рис.  10.8. Установка порта в сечении коаксиальной линии 

 
  Теперь зададим задание на расчет в диапазоне частот 1.5 ГГц – 2 ГГц (рис. 
10.9). 
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Рис.  10.9. Задание диапазона частот в режиме интерполяции 
 
    Нажмите Start. После выполнения расчета зададим вывод характеристики 
partial MagS(1,1,feed_pos) на двумерный график (рис. 10.10), а затем в 
разделе производной Derivative (рис. 10.11) выбрать переменную feed_pos. 
 

 
 

Рис. 10.10. Опции 
вывода 

характеристик 

Рис. 10.11. Выбор характеристики 
TuneS(1,1,feed_pos) 

 
 
 
    Теперь нужно открыть операцией Tune Report  диалог Report Tuning  
(рис. 10.12). 
 

 
 
Рис. 10.12. Наблюдение процесса смещения частотной характеристики 

антенны при изменении положения точки питания 
 
   Изменяя положение слайдера в окне Report Tuning, можно изменять 
положение точки питания антенны, и таким образом видеть, как при этом 
изменяется частотная характеристика. 
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Рис. 10.13. Вывод характеристики по оси y 

 
   После выполнения подстройки можно для заданного положения смещения 
точки питания рассчитать характеристики дальнего поля. Пространственная 
диаграмма направленности F-образной антенны показывается на рис. 10.14. 

 

Рис. 10.14. ДН планарной антенны 

   Итак, в этом разделе мы познакомились с такой операцией, как 
подстройка.  Кроме этого, в HFSS можно выполнить оптимизацию 
геометрии по заданной целевой функции, в которую включаются 
характеристики антенны. 

   В HFSS-13 реализованы градиентные методы поиска минимума целевой 
функции Quasi Newton, симлекс-метод, и методы случайного поиска Pattern 
Seach и Genetic Algorithm (генетический алгоритм).  
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11. Моделирование коннектора 
 
 
    В этом примере рассчитываются характеристики связанных линий 
сложной формы. Две крайние линии коннектора (римс. 11.1) замкнуты 
накоротко с земляной плоскостью. 
 
    Этот проект Connector  находится в папке Examples и выполняется 
методом Driven Terminal.  В конструкции имеется 4 порта, соединенные 
искривленными проводами. Земляная плата единая для всех портов, и 
находящихся внизу, и находящихся вверху конструкции. 
 

 
Рис.  11.1. Конструкция связанны 4-х искривленных линий 

 
    Коннектор (рис. 11.1) имеет дискретные порты на каждом конце двух 
внутренних окончаний искривленных проводников (pin).  Два внешних 
проводника заземлены с обеих сторон. Крайние параллелепипеды крепления 
(подложки) заполнены материалом  FR4. Граница излучения Radiate 
прикладывается к окружающему боксу.  
 
    Расчет выполняется с адаптацией сетки разбиения на центральной частоте  
5 ГГц.  Выберем метод расчета Driven Terminal (рис. 11.2) и единицы 
изменения мм.  
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Рис. 11.2. Выбор метода расчета 

 
   Все проводники в этом коннекторе созданы как трехмерные объекты из 
меди. В готовый проект Connector  в папке Examples установим порты и 
граничные условия. Порты и терминалы размещены в подложках FR4, 
которые расположены над и под связанными линиями (рис. 11.3). 
 

 
Рис. 11.3. Задание портов и терминалов 

 
   Порты наносятся на прямоугольные плоскости, а сверху на ребро 
устанавливаются терминалы (рис. 11.4). Особенностью метода Driven 
Terminal является то, что в одном сечении можно задать несколько портов с 
общей земляной шиной. 
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Рис. 11.4. Порты 1 и 2 и терминалы, слева и справа – КЗ 

 
    Установим порты 1 и 2 на средние площадки  (рис. 11.4). Порты 3 и 4  
подключены к этим же линиям, которые начинаются портом 1 и 2, но с 
другой стороны связанных линий (рис. 11.5). 
 

 
 

Рис.  11.5. Установка портов между проводником и земляной платой 
 

    Выведем диалог определения земляной платы (рис. 11.6) командой Assign 
Automatic. 
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Рис.  11.6.  В диалоге указывается, что проводник gnd  становится 
референсной плоскостью для всех проводных линий 
 
   Выбор опции gnd как “Use as Reference” показывает, что плата gnd 
устанавливается одна для всех проводов, для всех портов. 
       Расчет в полосе частот выполним методом интерполяции, так, что расчет 
выполняется от постоянного тока DC до верхней частоты  5 ГГц. 
 

 
Рис.   11.7. Вид соединителя коннектора 
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Рис.   11.8. Установки на решение 

 
       Для расчета в диапазоне частот зададим команду Add Sweep, выберем 
режим Interpolating и зададим частоты от 0 до 5 ГГц с шагом 0.01 ГГц (рис. 
11.9).  
 

 
 

Рис. 11.9. Задание диапазона частот анализа 
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    После запуска на решение, можно видеть процесс решения, нажимая 
правой кнопкой мыши на Setup1 и выбирая  Profile чтобы открыть диалог 
Solution. Данные о решении можно видеть в разделе  Convergence, Matrix 
Data, и Mesh Statistics. Можно видеть S матрицу, а также характеристики 
портов (рис. 11.10). 
 
 

 
Рис.   11.10. Рассчитанная S-матрица коннектора 

 
 
   Чтобы увидеть график S параметров, можно вывести в декартовую систему 
координат, добавляя график в разделе  Results (рис. 11.11). 
 

 
Рис. 11.11. Частотная характеристика S параметров 

 
    Из частотных характеристик рис. 11.12 можно сделать следующий вывод: 
линии имеют хорошее согласование, однако связь между отдельными 
линиями значительная. Так, между рядом идущими линиями |S23|= 0.8.  
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Рис. 11.12. Электрическое поле в сечении выводов коннектора 
 
 
   В заключение этого раздела отметим, что метод Driven Terminal 
применяется в том случае, когда  имеется несколько линий, связанных и 
имеющих одну земляную опорную основу. 
 

 
Рис.  11.13. Рассчитанное поле E  в сечении линий передачи, при 

возбуждении 1-го порта 
 
    Для того чтобы наблюдать и исследовать распространение поля при 
возбуждении какого-либо порта, или волны определенного типа в этом 
порту, нужно задать команду Edit Source и вывести диалог рис. 11.14, в 
котором выбрать модули и фазы источников, действующих в проекте. 
 

 
Рис.  11.14.Установка источников возбуждения на портах 
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Дискретные порты, реализованные в HFSS-IE.   В HFSS-IE 
реализованы дискретные порты, которые в методе HFSS-IE отличаются от 
аналогичных портов  в HFSS. Дискретный порт в HFSS-IE имеет 
напряжение, равной 1 Вольт между терминалом и его опорным выводом на 
земляной плоскости, в то время как дискретный порт в HFSS  задает 
электрическое поле на площадке.      Дискретные порты (рис. 11.15) подобны 
традиционным волновым портам, но могут быть размещены внутри 
структуры и должны иметь заданный пользователем комплексный импеданс. 
Дискретные порты рассчитывают S-параметры в сечении порта.   

 

   
Этот порт является 
внутренним к области 
решения. Прямоугольник, 
на который ставится порт 
касается к сигнальной 
линии, а с другой стороны 
касается земляной платы 

Этот порт является 
внутренним к области 
решения. С одной стороны 
прямоугольник касается с 
сигнальной линией, а с 
противоположной – с 
земляной платой 

Этот порт внутренний к 
области решения. Порт 
устанавливается на круг 
вокруг шара  

Рис.11.15. Реализация портов в HFSS-IE 
 

      Дискретный порт может быть задан на прямоугольнике, идущем от края 
линии до земляной платы (рис. 11.15). На всех ребрах дискретного порта, 
которые не соприкасаются с металлом или с другими границами, должно 
быть установлено граничное условие Рerfect H.  Эти установки зависят от 
того, какой режим выбран:  modal или terminal.   Важно отметить 
следующее: 
•  комплексный импеданс порта должен быть ненулевым, и сопротивление 
должно быть неотрицательным. 
• позволяется только одна мода, или только одна нагрузка (терминал), если 
решение выполняется в режиме terminal. 
• для сигнальных портов должна быть определена интегральная линия. 
• каждая нагрузка должны быть подключена к границе с идеальной 
проводимостью или бесконечной земляной плате. 
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             Считать, что порт создан верно можно только в случае, если 
максимальное расстояние от терминала до земляной платы меньше одной 
двадцатой длины волны. Если это условие нарушается, появляется 
предупреждение. 
 
    Современные цифровые устройства работают на частотах СВЧ. 
Характеристики линий передачи между процессорами и цифровыми 
блоками влияют на быстродействие компьютеров. Немаловажной является 
задача создания суперкомпьютеров, когда десятки, сотни компьютеров 
связаны в один суперкомпьютер. Поэтому одна из актуальных современных 
задач состоит в моделировании и проектировании линий связи в цифровых 
системах и устройствах. 
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12. Антенна, смонтированная на мачте 

 
 

Этот пример решается методом интегральных уравнений, который 
реализован в блоке HFSS_IE. Этот метод позволяет анализировать 
структуры больших электрических размеров.  

Рассмотрим в качестве примера антенну, установленную на 
металлической мачте. Она состоит из трех вибраторных антенн  (рис.12.1). 
Мачта расположена  на бесконечной заземляющей плоскости.  
 

 
 

Рис.  12.1. Антенна на алюминиевой матче 
 

Мачта имеет высоту 3.1 м. Вибраторы моделируются как 2-D объекты с 
границей PerfE. Возбуждения – дискретные порты. Крепежная структура 
моделируется полистироловыми держателями. Мачта стоит на проводящей 
земле, поэтому в проекте устанавливается активная опция бесконечной 
земляной платы InfGndPlane1 в разделе граничных условий (рис. 12.1). 

    Создаем новый проект, нажимая на . Выбираем единицы длины см в 
диалоге (рис. 12.2), вызываемой командой Modeler -> Units. 
 

 
Рис. 12.2. Единицы длины для черчения объектов 
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   Опции метода решения  HFSS-IE можно установить в диалоге рис. 12.3, 
которая вызывается командой HFSS->Options.  
 

 
Рис. 12.3. Установки опций метода HFSS-IE 

 
    Начертим мачту с высотой 270 см,  сечением 20 см x 20 см (рис. 12.4) и 
заполним материалом из библиотеки: алюминий. 
 

 
 

Рис.  12.4. Диалог параллелепипеда – мачты антенны 
 

    Далее начертим штырь,  создавая сначала  восьмиугольник, а затем 
превращаем в трехмерный объем, протягивая его по оси Z (рис. 12.5) 
командой Draw-> Sweep-> Along Vector. 
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Рис. 12.5.  Диалог, в котором редактируются размеры антенны-мачта 

    
    Далее выполним черчение полистироловых держателей (рис. 12.6). 
Размеры первого приведены на рис. 12.6. 
 
 

 
 

Рис. 12.6. Полистироловые держатели 
 
   Создание трех полистироловых держателей выполним командой Edit -> 
Copy. 
 
   Далее выполним черчение вибраторов антенн (рис. 12.7) в виде 
прямоугольников командой Draw ->Rectangle. 
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Рис. 12.7.  Диалог вибратора антенны 

 
Вибраторы состоят из двух плеч, между которыми установлен 

дискретный порт. Площадку для порта также чертим как прямоугольник 
командой Draw->Rectangle.  Геометрические параметры порта показаны в 
диалоге рис. 12.8. 
 

 
Рис. 12.8.  Параметры площадки для дискретного порта вибраторной 

антенны 
 
   Антенна на мачте стоит над бесконечной землей. Этот факт отражается 
тем, что в проект вводится земляная плата бесконечного размера (рис. 12.9) 
командой HFSS IE -> Boundary-> Assign-Infinite Ground Plane. 
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Рис. 12.9.  Антенна на 
мачте 

Рис. 12.10. Задание бесконечной земляной 
плоскости

 
     Земляная плата всегда задается в плоскости XOY. В диалоге рис. 12.10 
вводится координата по Z и шероховатость поверхности, от которой зависят 
потери земляной платы. Материал ее можно задать, нажимая на кнопку 
Select Material. 
   Задание на моделирование создается командой Add Solution, по которой 
выводится диалог рис. 12.11. Выполним задание на расчет антенны методом 
HFSS-IE. 
       
 

           
 
Рис. 12.11. Задание установки на расчет и разбиение на сетку в методе 

HFSS-IE 
 
     Расчет характеристик антенны выполняется на одной частоте 0.9 ГГц, 
поэтому установим адаптационный процесс на этой частоте (рис. 12.11). 
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Рис. 12.12. Характеристики антенны на матче 
 

    Запустите на решение, нажимая  Analyze. После расчета командой HFSS-> 
Fields -> Edit Sources установим возбуждение на всех трех портах (рис. 
12.12) и просмотрим ток, текущий по металлическому покрытию мачты и 
диаграмму направленности (рис. 12.13, рис. 12.14). 
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Рис.   12.13. Токи на 
поверхности мачты 

Рис.  12.14. Сечение ДН антенны на мачте 
 

                          
    В заключение отметим, что метод интегральных уравнений позволяет 
выполнить моделирование структур как с размерами, намного больше длины 
волны, так и с размерами, намного меньше длины волны. В качестве 
практического примера можно отметить расчет проводной антенны (рис.  
12.15) высотой 100 м, работающей в диапазоне волн 100 кГц. 
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Рис.  12.15. Проволочная антенна с растяжками 

 
    Размер этой антенны намного меньше длины волны. Входной импеданс у 
такой  антенны сверхдлинноволнового диапазона очень маленький. 
Увеличить его можно с помощью подбора количества оттяжек, выбора угла 
под которым оттяжки идут относительно земли. Входное сопротивление 
также значительно зависит от проводимости земляной поверхности. 
Основной задача проектирования такой антенны можно считать увеличение 
кпд (рис. 12.16), который зависит от частоты. 
     

 
Рис. 12.16. Частотная зависимость кпд зонтичной антенны высотой 110 м 

и с длиной оттяжек 110 м. 
 
    В структуре такой антенны могут возникать очень высокие напряжения. 
Для расчета напряжений между растяжками антенны можно разбить 
расстояния от отдельных фрагментов антенны до земли в виде отдельных 
элементов. Программа рассчитывает напряженности поля и напряжения на 
этих фрагментах, Используя, например, программу Exell, можно 
проинтегрировать суммарное напряжение и найти напряжение между 
антенной и землей. 
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     HFSS  может работать в тандеме и с другими  программами:  Mathlab,  
MathCAD, AutoCAD. 
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13. Расчет временного процесса в 
интегральной схеме СВЧ 

 
     
    Известно, что методами теории цепей можно выполнить расчет и в 
частотной области и во временной области. В HFSS-13 можно выполнить 
расчет во временной области, чтобы видеть распространение короткого 
импульса через устройство, в дополнение к получению S –параметров. 
      Программа расчета переходного процесса HFSS Transient – 
рассчитывает динамически изменяемое электромагнитное поле, используя  
дискретный метод Галеркина (DGTD - Discontinuous Galerkin Time Domain). 
Этот метод использует тетраэдральную сетку разбиения, и фундаментальный 
метод конечных элементов, который сделал HFSS стандартом точности в 
электромагнитном моделировании. Теперь можно выполнить исследования, 
задавая короткий радиоимпульс,  проникающий через землю, 
электростатические разряды, электромагнитные разряды и молнию. Можно 
также получить картину поля, которая меняется во времени  (TDR) при 
произвольном  заданном временном сигнале на входе.   
        Рассмотрим топологию (рис. 13.1) проекта Alinks_BGA, находящегося в 
папке Help инсталляционной папки HFSS (а не в папке Example). В процессе 
моделирования в этом проекте рассчитываются S-параметры в диапазоне 
частот, а также наблюдается распространение короткого импульса.  
          Геометрия имеет четыре сигнальных линии, которые подключены к 
портам и земляной шине. Выполним моделирование на уже созданной 
геометрии (рис. 13.1). Добавим возбуждения и установки на решение, перед 
анализом и выводом данных расчета. 
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Рис. 13.1. Структура распределительных линий 
 
        Нажмите HFSS>Solution Type  и установите метод расчета Transient 
(рис. 13.2). Это метод расчета процесса во временной области. 
 

 
Рис.13.2. Методы решения задачи в HFSS 

 

    Метод решения Transient имеет опцию  Network Analysis. Если вы 
выбираете опцию Network Analysis, то при установках на расчет появляется 
закладка входного сигнала, что позволяет выполнить, например: 

•  Моделирование возбуждением в виде импульсов, таких структур, как 
широкополосные антенны, световые волокна, электростатические 
разрядники; 

•  визуализацию поля при воздействии короткого импульса; 

•  анализ время-зависимых рефлектомеров. 

 
    Проверим установку граничных условий на готовой геометрии. 
Анализируемая структура представляет собой фрагмент СВЧ микросхемы. 
Он охвачен поверхностью air_box, на которую назначим граничные условия 
Radiate (рис. 13.3). Слева на рис. 13.3 приведены граничные условия, 
которые можно установить в методе расчета переходного процесса. 
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Рис. 13.3.Сложная форма поверхности Radiate 
 
           RadiationBoundary – граница излучения (рис. 13.3). Для точного 
моделирования объем формы, на стороны которого устанавливаются 
границы излучения, должен быть достаточно большой. 
     Другое граничное условие в разделе Boundaries, ReferencePlanes задается 
на земляные платы (“основания”) к портам. Так как сигнальные и земляные 
линии связаны с этими плоскостями, каждый сигнальный ток должен иметь 
замкнутый путь.    Выделим сразу две плоскости (рис. 13.4) 
BONDWIRE_REFPLANE_1 и SOLDERBALL_REFPLANE_1 и на них 
зададим условия Perfect E с именем Reference Plane. 
 

 
 

Рис. 13.4. Задание референсной плоскости (противовес) 
 
     Эти плоскости будут использованы при описании источников 
возбуждения.  
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    На рис. 13.3 можно видеть, какие граничные условия можно применить в 
режиме  HFSS Transient. Границы, недоступные для работы в этом режиме - 
это частотно-зависимые границы (слоистый импеданс, экранный импеданс 
screening impedance), которые непосредственно нельзя реализовать во 
временной области. 
 

      Задание источников возбуждения структуры. 
 

    1. Выберите первую из пока неописанных плоскостей LINK_12_BW в 
дереве проекта  и задайте на нем дискретный порт (рис. 13.5) командой 
Assign Axitation -> Lumped port. 
 
 

 
Рис. 13.5. Задание команды на создание дискретного порта в проекте 
 
2 . Появляется диалог рис. 13.6, в столбце  которого “Use as reference”, 
отметьте галочку, чтобы задать проводник SOLDERBALLREFPLANE_1 как 
опорную плоскость для терминала. 
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Рис. 13.6. Определение опций порта в режиме Driven Terminal 

 
    Таким же образом, создадим все 4 порта со стороны опорного проводника 
SOLDERBALLREFEPLANE_1. 
 
3. Откройте диалог свойств Properties для порта и в нем закладку Transient 
(рис. 13.7).  Не каждый порт должен быть “Active” (если задать активными 
все порты, то потребуется большое время, чтобы рассчитать всю S-матрицу). 
 

 
Рис. 13.7. Выбор состояния порта в режиме расчета переходного процесса 

 
    Если вы хотите уменьшить время расчета, сделайте только несколько 
портов активными. Пассивные порты будут работать как терминалы. Тогда 
вы получите только частичную S-матрицу. 
 
4. Откройте закладку Post Processing, и оставьте опцию Do Not Renormalize. 
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Рис. 13.8. Закладка постпроцессорной обработки данных 

 
  Если выбрать другую опцию, Renormalize All Terminals’ Spectral Domain 
Date, то данные будут нормализованы на термальные данные спектрального 
анализа. 
 
5. Выделите поверхность порта (в разделе Lumped Port) и кликните правой 
кнопкой мыши на  иконку этого порта в разделе  Excitation, и выберите 
“Auto-Assign Terminals”. По этой операции последовательно каждому порту 
автоматически создается терминал (нагрузка). 
    Отметим, что возможны и другие возбуждения в методе HFSS Transient. 
Однако некоторые задачи пока не решаются этим методом в версии 13: 
отдельные ячейки периодической структуры (фазированные антенные 
решетки, периодические частотноселективные поверхности)  или модели с 
магнитным смещением (ферритовые циркуляторы, ферритовые 
фазовращатели). Эти примеры лучше рассчитываются в частотной области с 
помощью  HFSS. 
 
Установки на расчет переходного процесса.   Сначала 
определим список фасок, на которых будут сохраняться рассчитанные поля 
переходного процесса, для чего: 
 
1 . Переключитесь на режим выбора фасок F и выберите курсором 
одновременно верхние фаски для сигнальной и земляной плоскости (рис. 
13.12), удерживая клавишу Ctrl. 
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Рис. 13.12. Выделение нескольких поверхностей 

 
2. Создадим список фасок командой Modeler>List>Create>Face List. В 
разделе List появится список FaceList1. Измените это имя на PlotFields. 
 
     Затем  подготовим установки на решение, для чего: 
 
1. Кликните правой кнопкой  Analysis>Add Solution Setup. 
 
2. В закладке  General (рис. 13.13) зададим максимальное количество шагов 
уплотнения сетки, равное 6. 
 

 
Рис. 13.13. Закладка General 

 
   Частота, на которой выполняется разбиение на сетку, будет находиться 
автоматически на основании выбранной временной зависимости. 
 
3. Выберите закладку Input Signal  (рис. 13.14). 
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4. Задайте широкополосный импульс от DC до 10 GHz и запросите расчет  
     S-параметров через каждые 10 MHz.   
 
  Заметим, что расчет во временной области можно выполнить,  задавая 
минимальную и максимальную частоты. Если вы задаете нижнюю 
граничную частоту, равной нулю, форма импульса изменится и будет 
включать частоты до постоянного тока. 
    Также заметим, что в дополнении к свипированию по частоте, может быть 
определен TDR импульс. Это - импульс,  спектр которого идет от DC до 
некоторой максимальной частоты, от которой зависит время нарастания. 
     Наконец, заметим, что вы задаете здесь одну временную зависимость для 
всех активных возбуждений. В проекте с  более чем одним общим 
переходным процессом (“non Network Analysis ”), можно задать различные 
временные зависимости для различных возбуждений, и выполнить 
моделирование одновременно со всеми возбуждениями. В методе расчета 
переходного процесса, все активные возбуждения имеют ту же самую 
временную зависимость, вы получаете один результат моделирования при 
одном активном возбуждением.  
 

 
Рис. 13.14. Закладка входного сигнала 

 
5 . Выберите закладку Duration (рис. 13.15). 
 



157 
 

 
Рис.  13. 15. Задание уровня затухания переходного процесса 

 
   Моделирование будет выполняться, пока переходные поля не затухнут до 
уровня Target Residual (рис. 13.15). Кроме того, максимальное время 
моделирования  определяется величиной  
 
                                   20x(размер модели) / (скорость света). 
 
    В этой линии передачи сигнал длительностью 1 нсек может несколько раз 
перемещаться от источника до оконечной нагрузки и назад. Поэтому резонно 
ограничить время расчета величиной  At most =1.25 ns (рис. 13.16), что равно  
вышеупомянутой 1 нсек, плюс длительности  входного сигнала. 
 

 
Рис. 13.16. Страница установки параметров временного процесса 

 
 
    Откройте закладку Saved Fields (рис. 13.17), и установите режим  
сохранения поля в плоскостях, устанавливая опцию  PlotFields.  
    Сохраняйте поля каждые 4 ps.  За время 4 ps сигнал углубляется на 0.6 мм 
в диэлектрике, так что такая частота выборок должна обеспечить плавную 
анимацию для этой модели. 
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Рис. 13.17. Установки на сохранение поля во время переходного процесса 
 
     В закладке Radiated Fields (рис. 13.17) выберем частоты, на которых будут 
сохраняться поля. Моделирование  потребует приблизительно  RAM  400 МБ 
на одно возбуждение. Если Вы установили все порты активными и имеете 
возможность выполнить распределенное моделирование, то выберите такой 
расчет. В распределенном моделировании по крайней мере с восемью 
процессорами и с достаточной RAM, каждый из восьми возбуждений дают 
собственный процесс, и они будут все решаться одновременно. Итак: 
 

1. Сохраните проект и запустите моделирование. 
 
     HFSS будет сначала выполнять адаптивный расчет во временной области. 
После этого, он будет выполнять восемь моделирований, одно на каждое  
возбуждение. 
 

2. После того, как расчет запущен, можно нажать правой кнопкой мыши 
на  Results>Create Terminal Solution Data Report>Rectangular Plot, 
чтобы в процессе расчета следить за входными и выходными 
сигналами на различных портах по мере выполнения моделирования. 
Выведем зависимости, выбирая нужные характеристики в диалоге рис. 
13.17. 
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Рис. 13.17. Вывод характеристик во временной области 
 
 
     Выберите входной сигнал  Input(LNK_12_bwire_T1), а также сигналы 
Output(TXCLK_12_bwire_T1, LNK_12_bwire_T1) и  
Output(TXCLK_12_sball_T1, LNK_12_bwire_T1). Тогда  создается график 
рис. 13.18. 
 

 
Рис. 13.18. График временного процесса 

 
     На рис. 13.19 по оси Y выводится параметр Residual (разница) в дБ. Это –
величина какого либо процесса, которая используется как критерий 
остановки. Устанавливается он в закладке Duration. По умолчанию, когда 
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пиковое поле спадает до 0.001 относительно  максимума, моделирование 
считается выполненным.  
   Контроль Residual графика во время расчета дает информацию, какое 
время моделирование может потребоваться.    Окно состояний дает 
дополнительную информацию; это основано на максимальном времени 
моделирования. 
 

 
 

Рис. 13.19. График переходного процесса 
 
    Разность не снижается до значения -60 dB, так как мы остановили 
моделирование раньше. 
 
 
             Постпроцессорная обработка матричных данных 
 
     В окне Report, в разделе Context, измените Solution от опции Time к 
Spectral. Это дает возможность составить график S-параметров в частотной 
области, полученный с помощью моделирования переходного процесса. 
Даже когда моделирование все еще выполняется, переходное решающее 
устройство уже даст S-параметры в частотной области, на основание 
информации о переходном процессе, который выполнился к настоящему 
времени. График будет модифицироваться очень часто. Моделирование 
может замедляться потому, что каждая модификация требует преобразований 
из временной области в частотную. 
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Рис. 13.20. Вывод частотных зависимостей S параметров, полученных с 

помощью БПФ в спектральной области 
 
     Характеристики S-параметров, выводимые во время моделирования 
показаны на рис. 13.21.  S-параметры, нанесенные на этом графике – это 
коэффициент отражения и передачи для конкретной сигнальной линии. 
    

 
Рис. 13.21. Частотная характеристика сигнальной линии 

 
         
     Чтобы вывести поле, распространяющееся вдоль линии: 
 
1.  В дереве модели, выберите список плоскостей PlotFields. 
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2. В менеджере проекта, кликните правой кнопкой мыши на Field 
Overlays>Plot Fields>E_t>Mag E_t. 
 
3. Выберите   Done. По этой команде на плоскости выведутся тангенциаль-
ные составляющие электрического поля. 
 
     Поле можно анимировать в плоскости резонаторов в последний момент 
времени, т.е. анимировать от 0.6 ns до 1.25 ns с подстройкой масштаба для 
поля. Пример анимации поля показывается на рис. 13.23.   
 

 
 

Рис. 13.22. Вывод поля и анимации его 
 
     

 
Рис. 13.23. Вид бегущего тока в соответствии с временным процессом 
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    Можно также видеть анимацию распределение поля и резонансные 
явления в последний момент времени. Анимацию от 0.6 ns к 1.25 ns можно 
видеть с подстройкой шкалы для поля. 
 

 
 

Рис. 13.24.  Вид бегущего поля вдоль структуры 
 
                          Вывод графиков во временной области 
 
    Исследование во временной области заключается в расчете реакции 
(отражения) во временной области (Time-Domain Reflectometry TDR) при 
возбуждении  структуры сигналом в виде скачка воздействия (переходной 
функции). В таком расчете нужно выбрать метод   Интерполирования. После 
выполнения расчета в диалоге Report нужно выбирать Time из списка 
Domain. Вы также должны определить входной сигнал, или шаг или импульс.  
 

 
Рис. 13.25. Выбор типа сигнала при задании временного процесса 

 
     При выборе области Time, вы можете выбирать из нескольких Categories и 
связанных Quantities, чтобы составлять график, например |S11|. Когда вы 
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составляете график во временной области, каждый параметр в частотной 
области сначала преобразуется во  временную область прежде, чем 
выполняется расчет по формуле. Например, если нужно вывести зависимость 

                                        S11 / (1 - S11)      (11) 

и вывести эту функцию во временной области,  то используется обратное 
преобразование Фурье IFFT: 

                                      IFFT(S11 * input) / ( 1 - IFFT(S11 * input) )   (12) 

      Отметим, что это выражение не соответствует выражению  

                                           IFFT( S11* input) / ( 1 - S11) * input ).   (13) 

      Эти два выражения не эквивалентны. 

     Если вы выбираете Time Domain Impedance как категорию Category, вы 
можете выбрать величину TDRZ.  Она определяет как 

              TDRZ(t) = Zref * ( 1 + IFFT(S11 * input) ) / ( 1 - IFFT(S11 * input) ) (14) 

     где "input" обозначает входной сигнал (step или impulse), а "IFFT(.)" 
обозначает обратное преобразование Фурье. 

    Это уравнение является отношением мгновенного напряжения во 
временной области v(t) к мгновенному значению тока i(t).  Напряжение и ток 
определяются (в частотной области) в терминах падающих и отраженных 
волн a и b, и равны   

aSZba ii )1()(ZV 00 +=+=     (15) 

aS
Z

ba ii )1(1)(
Z
1I

00

−=−=     (16) 

         Предположим, что падающая волна будет входным сигналом в виде 
ступеньки, и таким образом, когда мы берем обратное преобразование Фурье 
(IFFT) для  V и I, то получаем  v(t) и i(t) во временной области.  Создадим это 
отношение как функцию времени, и тогда получаем функцию  TDRZ(t). По 
умолчанию  Zo = 50 Oм. 

                 Чтобы создать график во временной области: 
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1. Для  проекта с существующим диапазоном изменения частот, нужно 
выполнить следующие шаги 2 - 4 для сохранения характеристики. 

2. В диалоге Report, в списке Domain, кликните Time. 

           Это позволяет выбрать кнопку  TDR Options и для рассчитанных 
нагрузочных данных включить Terminal TDR Impedance в список Category. 

3. Кликните кнопку TDR Options. Появляется диалог TDR Options. 

4. Выберите тип входного сигнала, Step (скачок) или Impulse (импульс 
Дирака). 

          Величина Step есть скачок изменения сигнала, тогда как  Impulse есть 
короткое возбуждение. Impulse это очень узкий прямоугольный импульс, со 
временем нарастания, равным нулю и временем спада с величиной 
временного шага равного 1 и высотой равной  1/(time step). 

   Выбор опции Step делает поля Rise Time и  Impulse неактивными. 

5. Если вы выбрали Step, введите время нарастания импульса в боксе Rise 
Time. 

               Время нарастания должно соответствовать частотам.   С шириной 
полосы от DC до Fmax, лучшее время разрешения, которое может быть 
достигнуто, равно 1/(2Fmax).  Время нарастания 1/(2Fmax) это самое короткое 
время нарастания, которое можно разрешить. Однако, время нарастания 
равное 0 s дает  ту же информацию, так что  0 есть величина по умолчанию в 
этой панели. 

6. Введите общее время на графике в текстовом боксе Maximum Plot Time. 

    По умолчанию максимально время в диалоге TDR Options связано с Δf в 
диапазоне частот: оно равно времени 1/2∆f,  в течение которого IFFT выдает 
информацию. Этот отрезок времени часто очень длительный, относительно 
временной задержки, которая соответствует длине тестирования вашего 
устройства, таким образом, вам захочется уменьшить эту величину. 
Альтернативно, вы можете отредактировать временные оси для 
характеристики TDR после того, как она была создана. 

7. Установите число временных точек для вывода на график  в бокс Delta 
Time. По умолчанию, это может быть равно количеству точек  в диапазоне 
частот. 

     Разница времени основана на полосе пропускания частот: с полосой 
частот от DC до Fmax наименьшее время разрешения, которое можно 
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получить, равно 1/(2Fmax). Алгоритм IFFT обеспечивает интервал между 
значениями частот 1/(2Fmax), но вы можете гладко интерполировать между 
точками, устанавливая самую лучшее разрешение, например, к 1/(10Fmax), за 
счет дополнительного времени вычисления. 

8.  По желанию, в окне TDR  измените тип окна и ширину. 

    Оконные функции в алгоритме быстрого преобразования Фурье  FFT 
сигнала чтобы получить ненулевые величины должны быть удалены от Fmax. 
Каждая оконная функция между способностью решить сопоставимые 
сигналы и частоты способностью решить сигналы различных сил и частот.  

     Список типов окон включает:  

Оконная функция Случаи использования
Rectangular Функция с низким динамическим диапазоном дающая хорошее 

разрешение для сигналов с близкими амплитудами.  Не 
подходит, когда сигналы имеют очень сложные амплитуды. 
w(n)=1. 

Bartlett Функция с большим динамическим диапазоном, с низким 
разрешением, подходит для широкого диапазона применений. 

Blackman Функция с большим динамическим диапазоном, с низким 
разрешением, созданная для широкого ряда применений. 

Hamming Модернизированная функция динамического диапазона, 
созданная для примеров с узкой полосой. 

Hanning (default) Функция модифицированного динамического диапазона, 
рассчитываемая для примеров с узкой полосой пропускания. 

Kaiser Выбор функции Кайзера также позволяет области определить 
связанный параметр Кайзера. Чем больше параметр Кайзера, тем 
шире окно. Параметр управляет компромиссом между шириной 
центрального лепестка и областью лепестков со сторон. 

Welch Этот подход применяется к окну параболической формы с 
данными в частотной области. 

9. Вы можете использовать Save as Default для установки текущих значений 
как умолчанию,  и кнопку  Use Defaults для использования ранее 
сохраненных опций. Заметим, что когда вы выбираете характеристику, 
сначала показывается величины, соответствующие  выбранной 
характеристики. 

10. Кликните OK. 

  Чтобы вывести характеристику  Terminal TDR Impedance (что означает, 
либо рассчитывать S-параметры для порта waveport1 в диапазоне частот, 
вместо расчета задержки относительно времени при конкретном импедансе), 
нужно сделать следующее: 

a. В списке Category, кликните Terminal TDR Impedance. 
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b. В списке Quantity, кликните величину для нанесения графика. 

     Импеданс по умолчанию (Zo) для величины  TDRZ составляет 50 ом, если 
Вы не определили по-другому, когда Вы устанавливаете импеданс 
перенормализации для терминалов, которые созданы в модели. Если нужно 
изменить величину импеданса, ее можно отредактировать в диалоге Report 
(как показано ниже), или Вы можете создать переменную Zo × (1+Sii) / (1-Sii) 
с выбранным  Zo. Отредактировать величину Zo можно в диалоге Report, для 
чего: 

1. В разделе  Category, выберите  параметры Terminal TDR Impedance, Port    
и Function.  

 

Рис.  13.26. Выбор времени по оси x 

2. Отредактируйте величину, которую нужно задать в поле Value.  В этом 
примере, величина для  Zo изменяется от значения по умолчанию  75 Ом при 
введении  ‘Zo=75ohm’ в поле Y-столбца. 

 

Рис.  13.27. Выбор функции по оси Y 

c. В разделе  Function, выберите mag для вывода модуля. 

3. Кликните Done.   Характеристика появляется в окне просмотра.  

     Если S11 = 0 на DC,  шаг временного интервала стремится к нулю, и шаг 
TDRZ  стремится к Zref. Если S11 будет отличным от нуля в DC, то ответ 
шага временного интервала устанавливается равным ненулевому значению, и 
TDRZ устанавливается равным величине, отличающейся от Zref.  Импульса 
временного интервала будет всегда спадать к нулю, как это можно видеть по 
производной характеристики. Переходной импульсный процесс TDRZ будет 
всегда нормироваться  на Zref. 
     График ниже показывает различие между коротким временем нарастания 
отличным от нуля и нулевым временем нарастания для сегмента линии 
передачи 94 Ом. Отметим, что характеристика с нулевым временем 
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нарастания начинается с верного импеданса линии, в то время, как импеданс 
в другие временные точки перенормализуется.  Кроме этого, одна 
характеристика - смещенная копия другой (рис. 15.25). Причина этого 
состоит в том, что напряжения и ток связаны нагрузкой 50 Ом, так что 
временной интервал сохраняется, v = Zref * i. Когда импульс нарастает, 
характеристика TDRZ начинает изменяться от установившегося состояния, 
потому что имеется отражение назад к источнику, импеданс которого 
отличается от характеристического импеданса линии передачи. 

 
Рис. 13.28. Временной процесс изменения импеданса TDRZ 

 
Отметим следующие моменты, которые нужно иметь в виду, используя 

TDR: Пространственное разрешение 

B
cx

2
=Δ      (17) 

где c - скорость света в среде, и B - полоса пропускания сигнала. Так как 
TDR обычно основан на диапазоне частот, который начинается с 
постоянного тока, то пространственное разрешение становится  

max2F
cx =Δ      (18) 

  
где Fmax - самая высокая частота в диапазоне частот. Например, если Fmax =  
15 ГГц и среда имеет проницаемость εr=4, то пространственный шаг будет 
равен (1.5E8 м/с) / (3E10 1/с) = 5 мм. 
    Пространственное разрешение, равное  c/(2Fmax) соответствует временному 
разрешению: 

   )2/(1 maxFt =Δ          (19)   
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Пусть N - число точек в IFFT. N равняется числу временных выборок, и это 
также равняется удвоенному числу частотных выборок. Плотность 
временных выборок в развертке частоты равна:   

                tNfF Δ==Δ /TIFFT) в  точекчисло(/2 max          (20), 

  где Т ‐ полное время. 
   Увеличение плотности частотных выборок приводит к увеличению полного 
времени T. На практике это часто приводит к большому времени затухания 
переходного процесса. Поэтому, в диалоге TDR Options можно установить 
максимальное время с меньшей величиной. 
    Интерфейс TDR Options также позволяет выбирать меньшее ∆t,  чем 
заданное уравнением (3) выше. Когда вы выбираете меньшее ∆t, вы 
увеличиваете Fmax "дополнением ноля", то есть добавлением нулевого 
значения для S11 вне расчетной ширины полосы частот. На практике это 
приводит к более гладкому сигналу TDR. 
     HFSS позволяет установить время нарастания входного сигнала. Время 
нарастания должно быть равно по крайней мере  1/(2Fmax). Входной сигнал с 
большим временем нарастания имеет меньшую плотность на высоких 
частотах и приведет к меньшему "звону" в характеристике TDR.  
    Фильтр Hamming или Hanning также уменьшит высокочастотное 
содержание и приводит к более гладкой характеристике TDR. С этими 
фильтрами можно выбрать ширину. Ширина 100 % часто - хороший выбор. 

      Для расчета временного процесса необходимо получить 
широкополосные модели SPICE. Это модели, которые отражают поведение 
электродинамических структур, но представляют собой модели с узлами. 
Это выполняет программа Full-Wave SPICE, которая   позволяет выполнить 
моделирование частотно-зависимых моделей SPICE, которые генерируются 
в форматах HSPICE, PSpice или Spectre RF для точного моделирования во 
временной области. Это обеспечивает получение широкополосных моделей 
SPICE одним нажатием кнопки. Программа Full-Wave SPICE - это 
добавочный модуль для  HFSS и Ansoft Designer. Она рассчитывает точные 
широкополосные модели  SPICE. Эта возможность позволяет разработчикам 
электронных компонентов учитывать СВЧ эффекты.  

     Программа Full-Wave SPICE позволяет пользователю реализовать:  

• Метод перевода от типов волн к узлам Modes-to-nodes technology; 
• Метод быстрого свипирования ALPS fast-sweep technology;  
• Алгоритмы создания моделей схемы SPICE.  

      Расчет временного процесса часто требует больших компьютерных 
ресурсов – памяти и времени. Поэтому рекомендуется при решении этих 
задач использовать распределенное моделирование. 
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    Распределенное моделирование требует лицензии  для выполнения 
расчета задач, которые требуют больших вычислительных ресурсов.  Эта 
лицензия называется High Perfect Computing (HPC).  Режим распределенного  
моделирования устанавливается в закладке Analysis Options, которая 
находится в диалоге  Tools>Options>General Options.  
 

 
 

Рис. 13.29. Задание опции распределенного расчета 
 
         Например, в диалоге рис. 13.29  пользователь имеет доступ к 
компьютеру с восемью, или большим количеством процессоров вызывается 
командой  \\ large_many_proc_machine. В диалоге рис. 13.29  компьютер 
перечислятся восемь раз, по числу процессоров. 
 
    Предположим, что  компьютер имеет 16 процессоров. Этому случаю 
соответствует установка, показанная на рис. 13.30. Это число может быть 
определено в закладке  Solver  диалога HFSS Options. 
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Рис.  13.30. Опции HFSS: число процессоров в распределенном режиме 

работы 
 
 

    В этом примере для тех процессов, которые не могут выполняться в 
распределенном режиме, пользователь запрашивает использование всех 16 
процессоров. Но например переходной процесс HFSS лучше считает в 
многопроцессорном режиме. Для распределенного моделирования, можно 
выбрать два процессора в разделе Number of Processors (рис. 13.30). 
Подробно методы реализации распределенного моделирования будут 
рассмотрены в разделе 17.  

 

   

 
 


